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CommPortal

INTRODUCTION

Welcome to Unified Communications! This guide is intended to get you up and running with the basic

features associated with the product.

As always, you can also contact our local customer care team at 800-860-2934 and we will be

happy to assist you.

CommbPortal is the web portal used to configure the features on your new phone system. With

CommpPortal, you can:

View missed calls

Listen to voicemailmessages
Manage your contacts
Setuprulestoroute yourcalls
Perform many other functions

To get started, go to the login page at: https://my.uc-view.com (Contact your administrator
regarding your 10-digit phone number and default password. Once you log in, you will be

prompted to create a new password.)

CommPortal Web

Please log in below.
Email /
Number:
Password:
Reset Password

) Remember me on this computer.

* This Guide is representative and may vary from your individual CommPortal scree
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GETTING ORIENTED

Once you are logged in, you will see Commportal Home Page:

Home Messages and Calls Contacts Start ~
: % Make Call
Phone StatUS ) start Meeting
m Forwarding Follow Me Screening

Summary of Configured Services

Calls that you receive will be processed according to the following rules.
All calls will ring your phone.
When busy, calls will be forwarded to voicemail. @

On no answer or when unavailable, calls will be Forwarded to voicemail.

X

Call Settings Message Notifications
Settings

Your Services

Personal Details Security Support
Change Password Help
Devices Change Call Services PIN 0 Downloads

Allocated Licenses Configure Account Email @ O Send Feedback

Change Voicemail PIN

The CommPortal Home page is the main screen for the portal where you can view your Call Manager

settings and access a range of other services.

1. Messages and Calls — Click this link to view and retrieve any voicemails.

Contacts — Import your contacts from Outlook or create new ones, click on a name to dial.
. Phone Status - Control your Call Manager settings.

. Make Call — Make a call direct from CommPortal.

. Start Meeting — Start an UC MaX meeting (only available with certain licenses).

Security - Use these links to change your password or security email address.

N s s W

Downloads — Download apps, for example Accession Communicator.

8. Send Feedback — Report bugs or make suggestions for improvements to the CommPortal
interface.

9. Your Services — Use these links to access a range of services available with your CommPortal
account, for example to change your call, message, and notification settings, or set up a reminder

call.
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MESSAGES AND CALLSTOOLBAR

Home Messagesand Calls(2) Contacts

Missed Dialed Received Deleted ol
[0 WIRELESS CALLER - (234) Sun 8/18, 1:05 am, 7 secs Actions ¥ x
Hi this is test voicemail.
O WIRELESS CALLER - (234) Sun 8/18, 1:03 am, 7 secs Actions ¥ x

Unable to transcribe. This failure has been reported.

Home Messages and Calls(2) Contacts Start ~ .

Dialed Received Deleted ol

Messages (2 New) I

[» | WIRELESS CALLER - (234) Sun 8/18, 1:05 am
Hi this is test voicemail.
(> | WIRELESS CALLER - (234) Sun 8/18, 1:03 am

Unable to transcribe. This failure has been reported.

WIRELESS CALLER - (234) Sun 8/18, 1:01 am
Home Messagesand Calls(2) Contacts Start ~ .
Messages (2 New) Missed Dialed | Deleted o
WIRELESS CALLER - (234) Sun 8/18, 1:04 am, 51 secs
WIRELESS CALLER - (234) Sun 8/18, 1:02 am, 50 secs
WIRELESS CALLER - (234) Sun 8/18, 1:01 am, 1 min
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The Messages and Calls tab displays all recent call activity. Here you can retrieve voicemails and

view calls based on whether they were missed, received, dialed, or deleted.

Click on one of the sub-tabs to get more detail. From the Missed, Dialed, and Received tabs you can

click on the name and either call them, add them to your contacts, or jump to the caller’s existing

contact information.

Use the action drop-down alongside each message Actions ¥t mark as Heard (or) New,

Forward as Email, or Forward as Voicemail, or click the trash icon to delete it.

Click the ‘play’ arrow button B 1o listen to a voicemail. Note that you can listen to your voicemails
in any order. A window (as shown over the Messages and Calls screen) will open to display the

Voicemail player where you can listen to and manage the message.

Click the ‘New Voicemail’ button at the top of the page to record and leave a voicemail as a

memo (your computer must have a microphone to use this function).
CONTACTS TOOLBAR

The Contacts page enables you to manage all your contact’s information. Within it, you can create
new contacts (using recent call information like a missed call, or create a new one from scratch),

create groups of contacts, or import/export your contacts.

Home Messages and Calls (1) Contacts Start ~
Contact List Speed Dials Extensions short Codes
Contacts and Groups Smith, John (John)
Search for... N_iarketing Mapag_er
First Communications
Select all (800)
< Smith, John (123) 456 7890

info@firstcomm.com

3340 W. Market St.
Akron

©Ohio

44333

United States

Personal Details Security

Support
Change Password Help
Devices Change Call Services PIN Downloads

Allocated Licenses Configure Account Email @ Send Feedback

Change Voicemail PIN
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The fastest way to add your contacts is to import them from your email program. If you use Microsoft

Outlook, follow these instructions:

¢ Open Outlook and go to the ‘File’ tab — then ‘Import and Export’

A New window should appear

¢ Select Export to File — click Next.

¢ Select Comma Separated Values from the list and click "Next”

Select Contacts from the folder tree and click “Next”

¢ Save exported file as ‘Outlook Contacts’ and click Next — save in a place you can easily locate
such as the Desktop or My Documents

¢ Go back to the CommPortal Contacts page

* Click the Import button

* Click the Browse button to find the ‘Outlook Contacts'’ file

Click Import

* Your contacts are now in CommpPortal

MAKING CALLS FROM COMMPORTAL

You can make a call direct from CommPortal by clicking ‘Make Call’ to launch the dialer.
Onthedialer, you can enterthe numberyou wantto call either by typingitin or selecting from a dropdown

list of your contacts, and also choose which of your telephone numbers will be used to make the call.

1. Click on'MakeACall’ 2. Enter number and click'Dial’
Dialer Dialer
Make a call to: / Make a call to:
enter number to call - 234 55> -
From: From:
My Phone Change My Phone Change

oo ] e =
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CALL FORWARDING

You can change settings of the following call forwarding services. Add numbers and click ‘Apply’.

¢ Immediate: Calls are forwarded as soon as you receive them.

¢ Busy: Calls are forwarded whenever your line is busy. If you have multiple (twinned) devices, then
this service only applies if all of your devices are busy (or reject the call).

* No Answer: Calls are forwarded if you do not answer your phone within a certain time.

* Unavailable: Calls are forwarded if your phone is unavailable (e.g. it is unplugged or loses power).

¢ Selective: Calls from selected callers are forwarded as soon as you receive them.

The forwarding tab also provides access to your forwarding destinations. These are numbers that

you regularly forward calls to, and that you preconfigure for ease of use.

Home Messages and Calls (2) Contacts Start +
Phone Status
Summary Follow Me Screening
Busy/No Answer F

Use same call forwarding configuration for both services.

Forward calls when no answer Forward calls when busy

@ Forward calls if you do not answer. ¥ Forward calls if your line is busy. @

Forward calls to: Forward calls to:
234

Hint: Use the Forwarding Destinations tab to add numbers that Hint: Use the Forwarding Destinations tab to add numbers that you
you frequently forward calls to. frequently forward calls to.

Forward unanswered call after 36 seconds.

FOLLOW ME

When enabled, this service redirects calls that you receive to one or more alternate
destinations.Youmayconfiguremultipledestinationstoringinturn, simultaneously,ora

combination of thetwo.
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To configure this service, you must define a number of rules.

¢ Each rule defines a destination you want to ring when you receive a call, and how long you wish
that destination to ring for.

* Each rule is assigned to a numbered step.

* As soon as you receive a call, all destinations referred to by rules in step 1 begin to ring
simultaneously.

* As soon as the last of these destinations has completed ringing, all destinations referred to by
rules in step 2 begin to ring simultaneously and so on.

* This continues until the call is answered or all configured destinations have been rung.

* You can have up to a maximum of 6 steps, and multiple rules may be assigned to each step.

To use Follow Me feature tick the checkbox and click on 'Add Rule'. Add alternate destination
numbers and select the order in which they should ring by adding them as different steps as

shown below.

Destination to ring Other v
Add Rule Clear List

Telephone Number: | 234: E . !
¥ Forward calls you receive to one or more alternate destinations.

Hint: Use the Forwarding Destinations tab to add numbers

that you frequently forward calls to. Step 1 Step 2 Step 3 Step 4 Step 5 Step 6
Ring destination for 36  secondsduringstep 1
Office
Permit forwarding? (> Yes @® No
CellPhone
Description CellPhone Office 2
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CALL SCREENING

You can change call screening settings by click on screening on home page. You can select Do Not

Disturb, Selective Rejection or Anonymous Rejection

Phone Status
Summary Forwarding Follow Me

Do Not Disturb Selective Rejection Anonymous Rejection

Reject calls if they are from selected callers.

Call To Reject

You are not rejecting calls from any numbers.
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SIMULTANEOUS RING

1. Launch CommPortal and Hit"Follow Me"

Home Messages and Calls

Phone Status

Summary of Configured Services

Calls that you receive will be processed according to the following rules.

All calls will ring your phone

When busy, calls will be forwarded to voicemail. @

On no answer or when unavailable, calls will be forwarded to voicemail.

Contacts

Start ~

Follow Me Screening

2. Place a check in the box that reads “Forward calls you receive to one or more alternate

destinations.” then click "Add Rule".

Home Messages and Calls

Phone Status

Summary

Follow Me

[ Forward calls you receive to one or more alternate destinations.

1

Welcome to Follow Me

Follow Me

Screening

Forward calls to your other phone numbers, either in sequence or at the same time

To begin, click the 'Add Rule' button above.

3. In the Pop-Up box, leave "My Phone” as the
“Destination to Ring” Set the Ring Duration fill

in the description, and Click "OK".

Destination to ring

My Phone E‘

Telephone Number:

Hint: Use the Forwarding Destinations tab to add numbers
that you frequently forward calls to.

Ring destination for | 20 seconds during step | 1

v

Permit forwarding? O Yes @ No

Description Desk Phone

CommPortal
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Destination to ring Other EI

Telephone Number: | 312-8
4. Click "Add Rule ! Change Destination to rng Hint: Use the Forwarding Destinations tab to add numbers

" "noe that r 1ty fi d calls to.
to “Other”, insert the number. Sl el S

Ring destination for| 20 | seconds during step| 1 |+~

Set the Ring Duration, fill in the description,
and Click "OK".

Permit forwarding? O Yes @ No

Description Jenny's Number

5. Click Apply and you are done.

Home Messages and Calls Contacts Start - -

Phone Status

Summary Forwarding Follow Me Screening

oliow Me

Add Rule

[ Forward calls you receive to one or more alternate destinations.

Step1 Step2 Slep3 Stepd Step5 Step6

Desk Phone

Jenny's Number

Note - If you add additional phones if you would like to have more ring. The call will ring in groups.
All phones in the “Step 1" will ring at the same time, then it will move on to another Step if you

configured one.

Phone Status

Summary Forwarding Follow Me
| AddRule | Clear List

[4 Forward calls you receive to one or more alternate destinations.

Follow Me

Step1 Step2 Step3 Step4 Step5 Step6

Desk Phone
Jenny's Number
Home Phone
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DEVICE MANAGER

You can customize your phone’s line key settings such as Speed Dials, Enhanced Call Monitoring
“BLF”, Enhanced Call Park “Orbits” and Intercom/PTT. Features are available based on your phone

make and model. To check your phone number and set keys hit the 'Devices' link.

Devices

1. Onceyouhitthe'Devices'link, | Devices
Click on'Set Keys' as shown below: Desk Phone  (330) set keys

Click Here

2. New window pops up as shown below. Click on 'Edit' to edit phone key settings

(Note Phone information may differ based on the phone you have).

@ my.uc-view.com

A& | Phone selection for Ford Test / S

Manage your phones

Yealink SIP-T42S
First Communications, LLC. Page 13
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3. Youcanchangesettings forall your phone line keys here as shown below (phone settings

may appear differently based on the type of phone you have):

| Yealink SIP-T42S - Edit settings for Ford Test / 330

» Programmable Keys - Soft Key
» Programmable Keys - Line Key
> Features

» Preferences

>Line1

>Line 2

»Line 3

»Line 4

>Line 5

>Line 6
>Line 7
?>Line 8
»Line9
>Line 10
»Line 11

v Programmable Keys - Line Key
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SPEED DIAL (CONFIGURE PHONE LINE KEYS)

To setup speed dials on phone line key hit the 'Devices' link.

Devices
1. Once you hit the 'Devices' link, -

Click on 'Set Keys' as shown: Desk Phone  (330) set keys

Click Here

2. Newwindow pops up asshown below. Click on'Edit' to edit phone key settings and select
"Programmable Keys - Line key”

(Note - Phone information may differ based on the phone you have).

@ my.uc-view.com )

ﬁ | Phone selection for Ford Test / [

¥ Programmable Keys - Soft Key

2 Programmable Keys - Line Key
Manage your phones / »Features

»Preferences

e >Line1

?Line 2
»Line 3

>Line 4
»Line 5
>Line 6
>Line7
>Line 8

Yealink SIP-T42S

»Line 9
Edit »Line 10
»Line 11
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3. Choose the key you want to edit, select "Speed Dial" from the list of options as shown

below:
wKey 2 Cell
Soft key action Speed Dial X Reset
Line @ Group Listening
Number @ Group Pickup
Hold
Label
Intercom/PTT
»Key 3
P KeyPad Lock
»Key
YKoy Last Caller ID Erasure
ey
LDAP
»Key 6
SKey7 Line Identity
»Key 8 Multicast Paging
Key 9 Paging List
»Key 10 Park Call
PKey 1 Prefix
»Key 12 Private Call Hold
»Key 13 Retrieve Parked Call
»Key 14
> Key 15 Trace Call
«~ Features Transfer
3 Dial Plan VoiceMail
«Call Log XML Group
Save Call Log @ _Zero Tauch _ 2

4. Add the phone numberyou wantto be set as speed dial, assign alabel to be displayed on phone

and hit save changes.

vKey 4 Ashwin

Soft key action Speed Dial ¥ Reset

Label Ashwin

O
*Number @ 123456789 &
@

Update phone(s) immediately when saving % Discard changes « Save changes o

5. Configuration settings will be instantly updated on your phone.
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SPEED DIAL (DIALPAD)

You can assign numbers to dial pad digits. For e.g on pressing digit 2 call (111) 111 - 1111

1. Click on "Contacts" and select "Speed Dials" 0

Home Messages and Calls (2) Contacts Start ~ Ashwin|

Contact List

Extensions Short Codes

Makes dialing Faster by allowing you to assign a one ¢ir two digit code to speed dial to different telephone numbers. One digit codes can range
from 2-9. Two digit codes can range from 20-49.

Clear List
You have no speed dials set up.
New Speed Dial
Speed Dial: 2 v
Number:

New Speed Dial

2. Select Speed Dial number to be Speed Dial: 2 v
assigned to the phone number and - 123456789
add 10-digitphonenumber, hit" Add" o

—

3. You can add more speed dials or hit "Apply" to save settings.

Contact List Speed Dials Extensions Short Codes

Makes dialing faster by allowing you to assign a one or two digit code to speed dial to different telephone numbers. One digit codes can range
from 2-9. Two digit codes can range from 20-49.

Clear List \m

Speed Dial Number New Speed Dial
2 123456789 x Speed Dial: 3 v
Number:
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ENHANCED MONITORED EXTENSION (BUSY LAMP
FIELD - BLF)

To setup monitored extensions on phone keys hit the 'Devices' link.

Devices
1. Once you hit the 'Devices' link, -

Click on 'Set Keys' as shown : Desk Phone  (330)- set keys

Click Here

2. New window pops up as shown below. Click on 'Edit' to edit phone key settings and select
"Programmable Keys - Line Key

(Note - Phone information may differ based on the phone you have).

@& my.uc-view.com

A& | Phone selection for Ford Test / ]

» Programmable Keys - Soft Key

> Programmable Keys - Line Key
Manage your phones / »Features

¥ Preferences
e »Line1
»Line 2
>Line 3
»Line 4

»Line 5
»Line 6
Yealink SIP-T42S >Line?
>Line 8
>Line 9
Edit >Line 10

»Line 11

First Communications, LLC. Page 18



CommPortal

3. Select "Enhanced Monitored Extensions" from the list of options as shown below:

w Programmable Keys - Line

dKey 1

wKey 2 Ashley
Soft key action Enhanced Monitored Extension v Reset
Extension Riones

Automatic Callback
Use Subscriber Name as Label @
Automatic Recall

Directed Pickup

Label
Enhanced Monitored Extension
d>Key 3 Michelle
Monitored Extension
»Key 4
Enhanced Call Park
»Key 5 Preet
Group Pickup
dKey 6

Last Caller ID Erasure

»Programmable Keys - Bottom

»User Line
3 Network Settings Line Identity

»Paging Groups Park Call

¥ Push-To-Talk Retrieve Parked Call (Specified Orbit)
>Advanced Spaed Dial

One Touch Transfer

Trace Call

Vaicemail

Macro Soft Key

4. Add phone extension, choose label options, and hit "Save changes"”

*Soft key action Enhanced Monitored Extension o Y Reset

Extension 9791 e

Use Subscriber Name as Label @
Yes - Requires the subscriber's full DN as the extension to

monitor

® No e
*Label Joe Smith o

Update phone(s) immediately when saving % Discard changes « Save changes o

5. Configuration settings will be instantly updated on your phone.
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ENHANCED CALL PARK (ORBITAL PARKING)

To setup ‘call park' feature on phone keys click on 'Devices'.

Devices
1. Once you hit the 'Devices' link, -

Click on 'Set Keys' as shown : Desk Phone  (330)- set keys

Click Here

2. Newwindow pops up asshown below. Click on'Edit' to edit phone key settings and select
"Programmable Keys - Line Key

(Note - Phone information may differ based on the phone you have).

@& my.uc-view.com [

& | Phone selection for Ford Test / ]

¥ Programmable Keys - Soft Key

»Programmable Keys - Line Key
Manage your phones /' »Features

¥ Preferences
e >Line1
?Line 2
»Line 3
>Line 4

»Line 5
>Line 6
Yealink SIP-T42S >Line7
»Line 8
»Line 9
Edit >Line 10

»Line 11
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3. Select "Enhanced Call Park" from the list of options as shown below:

»Programmable Keys - Soft Key

wLine Key 1-6 -- Column 1
2Key 1
vKey2 Park 1
Soft key action Enhancad Call Park v Rasat
Line @ Mans =
Park Orbit @ el
Label Automalic el Back
wKey 3 Automalic Recal
“Soft key action Conterence
a4 Directed Pickup
dKey 5
Directory
»Key 6
»Line Key 7-11 -- Column 5 DND
>Line Key 12-17 -- Column 2 Enhanced Call Park
»Line Key 18-23 -- Column 3
Enhanced Monitor Extension
»Line Key 24-29 -- Column 4
¥Features =
’Pmm Group Listening
dLine 1
Group Pickup
Line 2
»Line 3 Held
»Line 4 IntercomyPTT
»Line 5
Last Caller 1D Eraswre
dLine 6
SLine7 LDAP
¥Line 8 Ling Identily
»Line 9
o Multicest Paging

4. Select parking orbitand add a name to be displayed on your phone. Click "Save Changes"

vKey 2 Park 1
*Soft key action Enhanced Call Park o v Reset
Line @ Line 1 b 4

Park Orbit @ 1 o -
Label Park 1 o

Update phone(s) immediately when saving % Discard changes « Save changes o

5. Configuration settings will be instantly updated on your phone.

6. To retrieve a parked call dial *14 followed with the orbit number. For e.g. If you parked the call

on park orbit 1 dial *141 to retrieve the call.
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CHANGE SETTINGS

The panel at the bottom of the CommPortal

Home page allows you to make Call Settings Message Notifications
Settings
various changes to your settings. For

example:

* To change your password and/or PIN, or your security email address, click on the links under

Security at the bottom of the Home page.

(O EN N ENSTelie] - Tochange Commportal password
AEN s[RI« nENNEIN] - To change Voicemail PIN

* The Calls Settings page allows you to control various call settings, for example withholding

your caller ID and configuring Call Forwarding settings.

Home Messages and Calls (2) Contacts Start ~
Call Settings Message Notifications
Settings
Call Settings
General

Caller transfer is not available as no operator number has been set for your business group.
) withhold caller ID when making calls

If not withheld, signal my name as: AshwinManiyan
¥ Provide caller ID for incoming calls

¥ Provide caller name for incoming calls

Call Forwarding

Ask me for a forwarding number each time I turn on forwarding from my phone using an access code:
¥ Immediate Forwarding

¥ Busy Forwarding

¥ No Answer Forwarding

Call Blocking
Choose which types of phone numbers should be blocked.
O Local
J National and Mobile
International
Premium Rate
Operator
Directory
) Access Codes

") Access codes that change configuration
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* The Messaging Settings page enables you to control how your messages are handled, for
example you manage mailbox settings, customize how you are notified of a voicemail,
configure greetings, and more. Using Voicemail Greetings you can personalize your voicemail

greeting by recording an announcement (a microphone is required).

Home Messagesand Calls(2) Contacts Start ~

Notifications

Ca}l Message
Settings Settings

Message Settings

General

Incoming calls are forwarded to voicemail after 30 | seconds

¥ Transcribe voicemails in your inbox
! Enable live screening @

Forward messages as emails

Mailbox Access
¥ Fast Login
Auto-play voicemail

Voicemail playback | Details and Message v

Voicemail Greeting

Use the greeting: | System with name * v | edit

more options

Use a different greeting when I'min a call. record

! Use different greeting within my business group. record

DOWNLOADINGAPPS

You can use the Downloads link, located at the foot of the CommPortal Home page,
to access a range of apps that you can download onto your computer or your mobile/tablet so
that you can always have access to the key CommPortal features on your desktop or mobile

device.
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MORE QUESTIONS?

If you have any additional questions about setting up voicemail call us at 800-860-2934 or email
businesscare@firstcomm.com.

You can access all user guides here:

https://www.firstcomm.com/products/cloud-ip-pbx/user-guides/
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